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Chapter 1: Welcome to Estimating
Sage is pleased to welcome you as a client. Use this booklet to find out how Estimating can
help you organize, manage, and analyze hundreds of estimates.

Estimating gives you the flexibility, speed, and accuracy to generate competitive estimates,
bids, and budgets. An innovative spreadsheet interface is supported by fast takeoff tools, a
comprehensive price database, and a wide range of ways to analyze and fine-tune your project.

About This Booklet
This booklet covers the following topics:

n Get Help—a discussion of the Help system and useful contact information.

n Learn Basic Concepts—the concepts and philosophy behind Estimating.

n Use the Database BuilderWizard—quickly modify an existing database or build a new one.

n Create a New Estimate—learn how to create a new estimate.

n Perform Takeoff—instructions for copying information from a database to an estimate.

n Work With the Spreadsheet—learn how to navigate the Estimating spreadsheet.

n Print Reports—learn how to prepare and print reports.

n Use Address Book—learn how to set up Address Book to store your company information,
contact information, and vendors.

n UseDatabase Editor—learn how tomaintain databases with Database Editor.

Ways to Get Help
Use Estimating Help or the Sage Customer Portal to get answers to your questions.You can
also call Customer Support. See the following sections for more information.
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The Help System
Estimating’s efficient Help system provides faster access tomore information thanmost
manuals. With a click of themouse or a keystroke, you can easily get Help for a command, a
field, a window, or a procedure.

To Get Help on a Window Option

Help is available on virtually every option within a window. To access it, do one of the following:

n Click [What’s This?] on the toolbar or on the title bar and then click the option.
n SelectWhat’s This? from theHelpmenu and then click the option.

n Select the option and press [F1].

To Get Help for the Whole Window

For information about the window, such as the window's purpose and what tasks you can
perform in it, click [Help] at the bottom of the window.

To Use Help to Learn How to Do Tasks

Click [Help] on the toolbar or select Help Topics from theHelpmenu.

Contact Customer Support
Depending on your Sage Service Plan, youmay be able to take advantage of the following
services:

Sage Customer Portal
Youmay log on to the Sage Customer Portal at
https://customers.sagenorthamerica.com/irj/portal/anonymous/login to access any of the
following services:

n Knowledgebase: Find answers to your questions, access downloads, and subscribe to your
favorite articles. This service is available online 24/7.
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n Live Chat:Chat online with a customer support analyst - a great option for quick questions.
Chat hours areMonday through Friday from 6 a.m. to 3 p.m. Pacific time, with the same
exceptions as telephone support (see below).

n Online Support Request:Submit an online support ticket when you have a non-urgent
question. One of our call center support analysts will assist you. Online support hours are the
same as our customer support call center hours (see below).

Sage Customer Support Call Center
When you have amore urgent question or would prefer to speak to a customer support analyst
directly, call us at 800-551-8307. Telephone support is available Monday through Friday from 6
a.m. to 5 p.m. Pacific time with the following exceptions:

n Every Thursday from 2 p.m. to 3 p.m. Pacific time (closed for customer support staff
meetings)

n Standard United States holidays

n Quarterly company meetings

Upgrading Your Service Plan
If your service plan does not provide online or telephone customer support and you would like to
add or upgrade a service plan, please call 800-858-7098.

Training Information
Learn about the Anytime Learning and Realtime Learning sessions that are available, view
schedules of online sessions, or look for classroom training near you.

You can directly access Sage University from the Helpmenu in applications (Help > Sage
Timberline Office on the Web > Sage Software University). This website offers a variety of
professional product training options.
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Work With the Database and Estimates
Estimating stores information in two places: in a database of cost items and in your estimates.
The database is like a resource book that contains your estimating knowledge, including
information about items, prices, calculationmethods, and conversions. Each estimate contains
everything needed for a particular project, including the quantity and cost of material, labor,
equipment, subcontractors, and other items.

The database is the original source of the information for each estimate, but the database and
estimates are completely separate. If you update the database, information in the estimate
remains unchanged. However, you can automatically update an estimate with price changes
made in the database. Similarly, if you change the estimate, the database is not affected.

Learn About The Database
The database contains all the standard cost items you use, including item productivity factors,
waste factors, and prices. In addition, there are phases for organizing items, formulas for
calculating quantities, assemblies for taking off groups of items, subcontractors, crews, work
breakdown structures, andmarkups for adding special costs to the estimate.

Without a database, you would have to enter information over again for every estimate. But if
you set up a database, you can enter the information once and find just what you need for each
estimate. You simply copy information from the database into the estimate (a process known as
takeoff), and enter dimensions and specifications as required.

Access the Database From the Estimate
You can easily access the database when you are working on an estimate. This lets you change
or add new information to the database without closing the estimate. While changes made in the
database do not affect items that are already in the estimate, the new information appears in the
estimate the next time you perform takeoff.
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Learn About Estimates
In essence, the Estimating spreadsheet is the estimate. It presents the items, quantities, and
monetary amounts that make up an estimate, in a format designed specifically for estimating.
Because the Estimating spreadsheet is disk-based, your estimates are saved automatically as
you work.

NOTE: The database and estimates are stored in separate files. Before youmake
changes, be sure to note where your changes will be stored.

The Advantages of a Disk-Based Spreadsheet
In Estimating, every entry youmake to the spreadsheet is saved to the hard disk immediately.
There is no Save or Save As command on the File menu. This prevents you from losing data.

View Estimate Information
The spreadsheet window is the primary place where you view estimate information. From there,
you can open other windows to see totals for the estimate or the details associated with each
item.

In the spreadsheet, you control the placement of columns, whether they are visible, and even
what labels appear in the column header. You can also use a spreadsheet layout when you
create estimate reports.
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Figure 1: The Estimating Spreadsheet



Chapter 3: Use the Database
Builder Wizard
The process of setting up a complete and accurate database can be lengthy and time
consuming. The Database Builder is designed to walk you through the necessary steps of
setting up your databasemore quickly and efficiently, saving you time andmoney and allowing
you to take full advantage of the Estimating software.

Start the Database Builder Wizard
To start the Database BuilderWizard, open the Sage Desktop (Start > Programs > Sage >
Sage Desktop). In the Tasks pane, select Sage Timberline Office\Common
Tasks\Tools\Database Builder Wizard.

NOTE: Youmust have Database Editor installed in order to use the Database Builder
Wizard. The Database Editor is an available option when you install Estimating products.
For more information about installing Estimating products, see the “Install Estimating
Products” section of the GetStarted.pdf, which is located in the Documents folder on your
Estimating Products DVD.

The next section gives you a brief description of several of the windows in the wizard. The
actual windows you see and the order that they appear vary depending on the options you
select.

Start Here
Select themost appropriate method of creating or modifying your database. There are three
starting points from which you can choose. Each is tailored to how you want to build your
database. After you select the starting point, the remaining windows follow the same general
pattern.
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Choose from the following:

n Use an industry-specific database template: Use a pre-built database template as the
basis for your database. Each template is based on industry specific elements. You can
preview each database template before youmake a selection to find the one that works best
for you.

n Use an existing or partially-built database: If you have purchased a database, installed a
database but have not worked with it, or started building your own database from scratch,
select this option to locate that database. You canmodify the database and bring it up to date.

n Create a new empty database: If you would like to start from scratch to build a database,
select this option. The wizard provides tips and suggestions to help you get started building
your database.

Choose Your Industry/Choose a Database

Choose Your Industry
If you select to use an industry specific database template, this window is namedChoose
Your Industry. Select the database template that best fits your company. There are ten
industry specific database templates from which to choose. Each template has two different
formats, both based on the Construction Specifications Institute (CSI) MasterFormat numbering
scheme. MasterFormat 1995 organizes the database into 16 divisions andMasterFormat 2010
uses 48 divisions. Preview the template to choose the database that best suits your needs.

After you select the database template, browse to the location where you want to store the
database and give it a name.

Choose a Database
If you select to use an existing or partially built database, this window is namedChoose a
Database. You can browse to the database location or select Scan to find it.

Learn About Database Structure
Learn about how an Estimating database is structured. There are onscreen definitions and links
to Help topics that provide instruction on the organization of group phases, phases and items.
Take some time to become familiar with this structure as you get ready to plan how your own
database will look.
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Plan your Database: Phase Structure
If you are using a database template or an existing database, your database already contains
phases. However, theremay bemissing phases, unnecessary phases, phases that are not
numbered in the way you need, or phases with different descriptions than you want to use. In
this window, you can preview and print a report that list all of the phases that exist in your
database. Use it to plan how you want your database to look.

If you are creating a new database, your database is empty and you will not see this step.

Open in Database Editor: Phase Structure
The Database Editor application opens for you tomodify the phases in your database. In
Database Editor you can add, delete, rename, and renumber your phases. If you are using a
database template or an existing database, your phase table may includemany phases. If you
are creating a new database, your phase table is empty and you can start adding phases.

Plan Your Database Structure: Items
Use this window to:

n Print the Items report. Use this report to preview the existing items in your database and plan
changes them.

n Click [Modify Items] to make changes to the items in your database. You can add, delete,
change, move, rename, or renumber the items.

Learn About Estimating
The tutorials help you learn how to perform basic tasks in Estimating, such as creating an
estimate, performing takeoff, and updating the database from the estimate.

NOTE: ForWindows 2000, youmust haveWindows Media Player version 9 or later to
view the tutorials. You can downloadWindows Media Player fromMicrosoft’s Web site.



Chapter 4: Create a New Estimate
Create a New Estimate
To start an estimate, youmust specify a folder and file name for the new estimate. Use the File
menu to start a new estimate from scratch, create a duplicate of an existing estimate, or merge
several existing estimates into one new estimate.

To Create a New Estimate:
1 On the Filemenu, click New Estimate.
2 Enter a name for the estimate on theEstimate File Name tab.

3 Click on the Folders tab and specify:

p The folder in which you want to store the estimate.

p The folder containing the database that you want to use for the new estimate.

4 Click [OK]. TheEstimate Informationwindow opens.
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Figure 2: The Estimate InformationWindow

5 Complete the fields on the tabs. At aminimum, you need to complete theProject name field.
The Job size field is required if you want Estimating to calculate the unit cost for the job in
the Totalswindow.

6 When you finish entering information about the estimate, click [OK].
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Perform Takeoff
After you create an estimate, you select items and specify their estimated quantities. You can
enter takeoff quantities or have Estimating calculate them for you. When you perform takeoff,
Estimating copies everything associated with the selected items into the estimate and
calculates their takeoff quantities.

Quick Takeoff
Quick takeoff is a fast, easy way to get items into your estimates. You have the option to
specify takeoff quantities before or after items are in the spreadsheet. Once there, you can
specify the item quantities by:

n Using the formula attached to each item.

n Using the Estimating or Microsoft Windows calculator.

n Using one value to fill in other quantities.

n Using Enter Dimensions.

n Makingmanual entries.

To Perform Quick Takeoff:

1 Click [Quick Takeoff] on the toolbar to open theQuick Takeoff window.
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Figure 3: TheQuick Takeoff Window

2 (Optional) Click [Item Takeoff Settings] on the toolbar to set a location and work
breakdown structure (WBS) for the items you are going to take off.

3 Select an item and take it off using one of the followingmethods:

p Locate the item in the list and then double-click (or drag and drop) the item to take it off.

p Click [Search] to open theSearch field, in which you can enter search criteria for the
item. After you find it, double-click (or drag and drop) the item to take it off.

p Select an option from theSort item list by drop-down list to organize the list in a
different sort order. You can sort by phase/item or description. You can also use a
custom sort based onWBS codes. Locate the item in the list and then double-click (or
drag and drop) the item to take it off.

4 Take off additional items in the samemanner. You can select multiple items in the list.

5 Enter or calculate the item takeoff quantities. To calculate quantities you can:

p Use the calculator.

p Use formulas.

p Manually enter quantities.
You can also right-click in the takeoff Quantity column to select these additional options:

p UseEnter Dimensions. This option is only available after you use your mouse to select
multiple cells in theQuantity column.
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p UseDigitizer (if you ownDigitizer).

Use ePlan Takeoff (if you own ePlan Takeoff).

Item Takeoff
Item takeoff is a convenient way to take off groups of items and quickly calculate their takeoff
quantities. You can review items andmodify them for use in the current estimate before you
generate them to the spreadsheet.

To Perform Item Takeoff:

1 Click [Item Takeoff] on the toolbar to open the Item Takeoffwindow.

2 (Optional) Click [Item Takeoff Settings] on the toolbar to set a location and work
breakdown structure (WBS) for the items you are going to take off.

3 Select an item and take it off.

4 (Optional) Right-click on the item list and Sort item list by to organize the list in a different sort
order. Or select Search to find a specific item in the list.
If you have formulas assigned to your takeoff items, Estimating displays the variables
(dimensions and specifications) for them in the variable pane.

5 Enter the item takeoff quantities in the takeoff grid.

6 Review the items in the takeoff grid. If necessary, you can change an item description,
change item details, delete an item from the grid, and save the items as an assembly.

7 Click [OK] to generate the items to the spreadsheet.

Assembly Takeoff
You can streamline the takeoff process by taking off assemblies. For example, instead of taking
off each item that makes up a standard-sized wall, you can take off an assembly containing all
the items needed to construct the wall.

To Perform Assembly Takeoff:

1 Click [Assembly Takeoff] on the toolbar to open theAssembly Takeoff window.
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Figure 4: The Assembly Takeoff Window

2 (Optional) Click [Item Takeoff Settings] on the toolbar to set a location and work
breakdown structure (WBS) for the assemblies you are going to take off.

3 Select an assembly and take it off.
If you use formulas in your assemblies, Estimating displays the variables (dimensions and
specifications) for the assembly in the variable pane.

4 Enter the variable amounts in the variable pane or enter a takeoff quantity in the takeoff
grid. Click [Add Pass] to calculate quantities for items with formulas.

5 Review the items in the takeoff grid. If necessary, you can change an item description,
change item details, add an item to the assembly, delete an item from the grid, or substitute
an item in the grid.
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6 When you are ready to generate the assembly to the spreadsheet, click [OK] in the
Assembly Takeoff window.

Review Assemblies
You can review and change assemblies already in the estimate. Estimating tracks all of the
passes generated during assembly takeoff and lets you:

n Check the dimensions entered for each pass.

n Change dimensions andmake additional passes for the same items.

n Change dimensions and replace existing passes.

n Add or delete items.

n Attach a note to any pass.

To Review a Pass:
1 From the Takeoff menu, select Review Assemblies.

2 Double-click the assembly that you want to review.

Figure 5: Reviewing an Assembly

3 Click the pass that you want to review.
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To Revise an Existing Pass:
1 In the variable pane, change the dimensions in theQuantity, Length, andWidth boxes.

2 Click [Replace Pass] to revise the existing pass.

3 Click [OK] to send the changes to the spreadsheet.

NOTE: You can also add a pass [Add Pass], add notes to a pass [Pass Note], or undo a
pass [Undo Last Pass].

One-Time Item Takeoff
One-time items are items that do not already exist in your database. They may be unusual items
that you want to include in an estimate without first having to set them up in the database.

To Perform One-Time Item Takeoff:

1 Click [One-Time Item] on the toolbar. TheOne-time Item window opens.

Figure 6: TheOne-Time ItemWindow

2 Complete the fields in the window. At aminimum, you need to complete thePhase,
Description, and Takeoff unit fields to set up a one-time item.

3 (Optional) Click [Go to Detail] to enter more information about the item.
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4 When you finish setting up the item, click [OK] in theOne-time Item window. The item
appears on the spreadsheet or in the takeoff grid if you are taking off a one-time item from the
Item Takeoffwindow. Hyphens in the Item column (----) identify a one-time item in the
spreadsheet. If you did not select [Go to Detail] in step 3, you can enter details directly to the
item in the spreadsheet.

NOTE: If you want to add your one-time items to your database, you can easily do so by
selectingPricing > Update Database > Save One-time Items to Database.

Add New Item
You can add new items to your estimate from within quick takeoff, item takeoff, or assembly
takeoff, if your settings allow it.

To review your settings, select Edit > Options. On the Takeoff tab, confirm that the Include
Add New Item entry on takeoff lists check box is selected, and then click [OK].

To Add New Items in Quick Takeoff:

1 Click [Quick Takeoff] on the toolbar to open theQuick Takeoff window.

2 Double-click on the group phase and then phase where you want the new item to appear.

3 Double-click Add New Item. This creates a new row on the estimate under the phase you
selected.

4 Close theQuick Takeoff window.

5 Enter the item information in the new row on the spreadsheet.

To Add New Items in Item Takeoff:

1 Click [Item Takeoff] on the toolbar to open the Item Takeoff window.

2 Double-click on the group and then phase where you want the new item to appear.

3 Select Add New Item. This adds a row to the item takeoff grid, where you can enter
information for the item.

4 Enter the item information in the takeoff grid.

5 Click [OK] and then [Close] to add the item to your estimate.
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To Add New Items in Assembly Takeoff:

1 Click [Assembly Takeoff] on the toolbar to open theAssembly Takeoff window.

2 Select an assembly and take it off.

3 Right-click in the assembly pane, and then select List Items.

4 Select the group phase and then phase where you want to add the new item, and then click
Add New Item. This creates a new row on the assembly grid, where you can enter
information about the item.

Figure 7: Adding New Items to the Assembly Takeoff

5 Enter information about the new item in the assembly grid.

6 When you are ready to generate the assembly to the spreadsheet, click [OK] in the
Assembly Takeoffwindow.

NOTE: If you want to add your new items (which are now one-time items) to your
database, you can easily do so by selectingPricing > Update Database > Save One-
time Items to Database.
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Spreadsheet
The Spreadsheet Window
The spreadsheet window contains columns with the quantities and category information for all
items in the estimate.
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Figure 8: The Estimating Spreadsheet

Spreadsheet Window Toolbar
A toolbar is available at the top of the spreadsheet window for easy access to the common
commands described below. For information about accessing these commands using keyboard
shortcuts, refer to the appendix.

NOTE: In this booklet, instructions that include these commands often include a picture
of the icon as well.
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Table 1: Spreadsheet Command Icons

Icon Command Purpose

Expand Displays the spreadsheet with onemore level
of detail.

Collapse Displays the spreadsheet with one less level of
detail.

Find/Goto Lets you search for items that match the sort
level or description you specify.

Spreadsheet
Layout

Lets you create, modify, delete, or apply a
custom layout to the spreadsheet.

Quick Takeoff Perform takeoff directly from the item list.
Available only when a database is open.

Item Takeoff Opens the Item Takeoff window, in which you
choose the items and specify their takeoff
quantities. Available only when a database is
open.

Assembly
Takeoff/Review

Opens the Assembly Takeoff window, in
which you choose an assembly and specify the
takeoff quantities for its items. Available only
when a database is open.

One-time Item Creates a one-time item for the current
estimate. You enter the phase, description,
takeoff quantity, unit, and categories.

Item Takeoff
Settings

Controls the automatic assignment of location
andWBS values during takeoff.

Detail Lets you view andmodify the information about
an item in the estimate spreadsheet or takeoff
grid.

Totals Lets you view the overall total and category
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Icon Command Purpose

totals for the current estimate and assign
addons (markups).

Combine Lets you combinematching items in the
spreadsheet.

Scan Lets you find incomplete items in the
spreadsheet.

What’s This? Displays Help for a button, command, or
window.

Change the Appearance of the Spreadsheet
The spreadsheet includes over 100 columns of information. Estimatingmakes it easy for you to
adjust the appearance of the spreadsheet to suit your needs.

You decide:

n Which columns are visible and where they are positioned.

n What names appear as column headers and how wide each column is.

n Whether you want to organize items by phase, location, takeoff order, assembly, or a
customized spreadsheet sequence.

n How many levels of detail you want to see.

n What fonts and colors are used for text and numbers.

In addition, you can set up an unlimited number of layouts. For example, you can design a labor-
only layout or amaterial-only layout.

To Set Up the Spreadsheet Layout:

1 Click [Spreadsheet Layout] on the toolbar to open theSpreadsheet Layouts window.
This window lists the layouts set up for the current spreadsheet sequence.

- 23 -



Chapter 6: Work with the Spreadsheet

- 24 -

Figure 9: TheModify Spreadsheet Layout Window

2 Click a button in theSpreadsheet Layoutswindow to continue.

p To set up a new layout, click [Add].

p Tomodify an existing layout, select the layout in the list and click [Edit].

p To save the current layout, select <Current layout> in the list and click [Edit].

p To delete a layout from the list, select the layout in the list and click [Delete].

3 Set the options in theModify Spreadsheet Layoutwindow.

p To show a column in the spreadsheet, select the correspondingVisible check box.

p To hide a column, clear the correspondingVisible check box.

4 Click [OK] to save the spreadsheet layout and close theModify Spreadsheet Layout
window.

Change Item Prices and Quantities
As you work on an estimate, you can change prices and quantities to reflect the latest
information. For example, you can enter quotes for materials.

To Change Prices and Quantities:
1 On the spreadsheet, click the appropriate category Price cell for the item. For example, to
enter a quote for an item's material price, click theMaterial Price cell.

2 Enter the new price.

3 If other items in the spreadsheet are linked to this item, the following question appears: Would
you like to update prices for linked items?

p Click [Yes] to change the prices of linked items too.
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p Click [No] to change the price of this item only.

4 If the spreadsheet contains duplicates of this item, the following question appears: Would you
like to update prices for duplicate items?

p Click [Yes] to change the prices of duplicate items too.

p Click [No] to change the price of this item only.

Find Incomplete Items
Tomake sure your estimate is complete, you can scan it for missing takeoff quantities, prices,
amounts, or subcontractor names (if an item has a subcontract amount).

To Scan for Incomplete Items:
1 Position the cursor anywhere on the spreadsheet.

2 Click [Scan] on the toolbar.

3 Estimating stops at the first cell that is empty or contains a zero. Fill in themissing quantity,
amount, price, or subcontractor name. If you need to domore research before you supply a
value, leave the cell blank for now.

4 Repeat step 2 until nomore incomplete entries are found. (When Estimating reaches the
bottom of the spreadsheet, it resumes scanning from the beginning of the spreadsheet.)

The Detail Window
TheDetail window lets you view the information about a row in the estimate spreadsheet or
takeoff grid. This window contains information about the selected spreadsheet row as specified
for the estimate. Estimating saves your entries when you click [OK]. Changes youmake are
saved with the estimate and do not affect the database.

To open the Detail Window:

1 On the toolbar, click [Detail].

2 From the keyboard, press [CTRL] + [D].
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Figure 10: The Detail Window

The Totals Window
The Totalswindow shows a summary of the cost category and estimate totals. It also lets you
include addon costs (markups) in the estimate.

To Open the Totals Window:

1 Click [Totals] on the toolbar or press F4.
The Totals window opens. You can see the totals for each cost category, markup and
subtotal along with the total cost of the estimate.
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Figure 11: The Totals Window

2 To print the totals, click the print icon on the toolbar. If the toolbar does not appear, click
[Show Toolbar].

Format the Totals Window
You can format the Totalswindow to change its visual appearance. You can also hide fields to
prevent them from printing on reports. Any layout changes youmake to the window print on your
report if the option to print totals is selected on your report.

To Format a Column in the Totals Window:
1 With the Totalswindow open, right-click on a column heading and select Format Column.
The Format Columnwindow appears.

2 Make changes to the column. Changes you canmake include:

p Column name

p Columnwidth

p Alignment

p Number of decimals

p Background color

p Font
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3 Click [OK] to save your column changes.

NOTE: You can also format rows or individual cells. To format a row, right-click on the
row header and select Format [row name] Rows. To format a cell, right-click in the cell
and then select Format Cell.

To Hide a Column on the Totals Window:

Hiding columns prevents them from showing up on reports, but does not remove the amounts
from the totals.

1 With the Totalswindow open, right-click on a column heading and select Hide On Reports.

2 If you receive a warning that hidden numbers may cause some totals to appear incorrect,
click [OK]. (This does not mean the numbers are incorrect, only that they may appear to be,
because numbers that are used in the total calculation are not visible.)

3 Click [OK].

NOTE: You can also hide rows or individual cells. To hide a row, right-click on the row
header and select Hide on Reports. To hide a cell, right-click in the cell and then select
Hide on Reports.

To Insert Addons:

Addons represent the additional cost or markup that contractors add to their estimates. It is cost
over and above the actual cost to contractors and represents their indirect costs and budgeted
profit. Types of addons include overhead, taxes, profit, and other costs.

You can choose addons for the estimate before or after takeoff. Some estimators like to set
them up before takeoff so that they can see how the overall estimate is shaping up as they
work.

Where you insert each addon determines which estimate costs are used to calculate the addon
amount. An addon should come after the subtotals and addons you want to include. This is
especially important for addons based on subtotals.

1 Right-click on the row header where you want to create the addon.

2 Select Insert Addon.
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Figure 12: Inserting an Addon

3 Double-click the addon to select it. You can select multiple addons if necessary.

4 When finished, click [Close].

5 Click [OK].

To Insert Subtotals:

Where you insert a subtotal determines which estimate and addon costs it includes. Each
subtotal is the sum of the amounts between it and the previous subtotal.

1 Right-click on the row header where you want the subtotal to appear.

2 Select Insert Subtotals.

3 (optional) Type a description in the Description column.

Create Totals Page Templates
Changes youmake to the Totalswindow are stored with the estimate. You can also save the
Totalswindow format to the database as a template so that it is available to use on other
estimates.
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1 With the Totalswindow open, click [Totals Pages Templates] > Save As Totals Page
Template.

2 In the Template name box, type the name for this template.

3 If you want to use this template for all new estimates, click theUse this totals page
template for new estimates check box.

4 Click [OK].

NOTE: To revert back to the system default template, select [Totals Page Template] >
Use System Default Template.

Docking the Totals Page
You can dock the totals page, which places it in a location on the screen that you select.

Dock the Totals Page:
1 With the totals page open, click [Dock].

Figure 13: Docking the Totals Page

2 Select the location where you want the totals page to appear. The page automatically moves
to the location you select. If you dock the page and later want to undock it, repeat these steps
and select Undock.
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Print Reports
You can print a report on paper, preview it on your screen, or export it to a PDF file, an Excel file,
or an ASCII text file. The printing procedure is similar nomatter which report you choose to print.

You can also set up customized cover pages, headers, footers, and a signature block for each
estimate report. Once you have a presentation you like, you can save it to a named layout for
printing that report in the future.

To Print a Report:
1 Open an estimate. (Youmust have an estimate open because the report information comes
from the current estimate.)

2 On theReportsmenu, select the report you want to print.

3 (Optional) To customize the report, click [Report Options] to open the report options
window. In this window you can select which records print, sort the report information,
change the fonts or colors, change the page setup, set up headers and footers, or set up a
signature block.
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Figure 14: Selecting the Report Options

NOTE: For theSpreadsheet report, you can click [Prefill from Spreadsheet] to change
the report options tomatch the current layout of the spreadsheet. This is an easy way to
get a printout that looks the same as the spreadsheet on the screen. If you prefer a
different layout for the report, you can change the spreadsheet layout before you print.

4 (Optional) To check the appearance of the report before you print it, click [Preview].

5 (Optional) To save your changes for the future, click [Save Layout] and give the layout a
name. You can select this layout name in the future to use these changes.

6 Click [Print].

To Save a Report as a File:
1 In the report window, click [Export].

2 In theExport Report Filewindow, select the drive or directory in which you want to save the
report. Then enter a name for the report in the File Name field.

3 In theSave as type field, choose a file format. Your choices are:

p Portable Document Format (*.pdf)

p Microsoft Excel Workbook (*.xls)
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p Microsoft Excel XML (*.xml)

p CommaSeparated Values (*.csv)

p Tab Separated Values (*.tsv)

p Text Files (*.txt)

4 Click [Save].

To Preview a Report:
1 From theReportsmenu, select the report you want to preview.

2 Click [Preview].

3 In the preview window, use the buttons at the top of the window tomanipulate the display.

Table 2: Preview Button Functions

Button Action

[Print] Starts printing the report.

[Next Page] Previews the next page.

[Prev Page] Previews the previous page.

[One Page] Shows one page at a time.

[Two Page] Shows two pages at a time.

[Zoom In] Makes the pages larger.

[ZoomOut] Makes the pages smaller.

[Close] Returns to the previous window.
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Use Address Book
Address Book is a company-wide database of company and person contact information that can
be shared by other Sage Timberline Office applications. Contacts for Estimating include the
subcontractors, clients, engineers, and architects you work with, as well as your own company
information.

Address Book is available in Estimating wherever you need contact information. For example,
when you need to assign a subcontractor to an item, you can open the Address Book contact
selection list from the estimate and select the subcontractor you want to use.

Other tasks in which you access Address Book from Estimating include:

n Edit a subcontractor, company contact, or person contact.

n Select your company (Company tab in theDatabase Settingswindow).

n Select the client's company (Client tab in theEstimate Informationwindow).

n Select the architect's company (Architect/Engineer tab in theEstimate Information
window).

n Select the engineer's company (Architect/Engineer tab in theEstimate Information
window).

n Select the default subcontractor or vendor for amaterial class (Material Classwindow).

Select a Company Data Folder
The company data folder contains an Address Book database, Job Cost data, and other
information that is used in Estimating. You need to select a company data folder to access this
information. You do not have to connect to a company folder to work with Estimating; you can
enter contact and job cost information and save it to the estimate instead. However, if you want
consistent information in your estimates or need tomake contact information available in other
Sage Timberline Office applications, youmust connect to a company folder.
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NOTE: If you want to select a shared data folder on amapped drive, map a drive letter to
the data folder before you begin. Use the same drive letter and path that other workstations
use to access the folder.

To Select a Company Data Folder:
1 From theDatabasemenu, select Database Settings.

2 On theCompany tab, select the location of the company data folder that contains your
Address Book and Job Cost information. Click [Select] to choose from a list of company
folders.

NOTE: If you cannot find a folder, youmay not have access to the company folders that
are used by your accounting department because you do not have a Sage Timberline
Office accounting application installed on your workstation. Address Book requires certain
program files when accessing databases used by both Estimating and accounting
applications. You can set up your workstation to recognize accounting data folders without
installing an accounting application. Refer to the Help “Setting up a workstation to
recognize Sage Timberline Office accounting data folders” for more information.

3 (Optional) To configure your database to use Job Cost data stored in this folder, click on the
Job Cost tab. Select Sage Timberline Office as the job cost interface type, and click the
Use Sage Timberline’s Job Cost data option.

4 When you finishmaking changes, click [OK] to save them.

5 Click [Close].

Set Up Subcontractors
You create a subcontractor in Address Book when you want to use the subcontractor in more
than one estimate or to make the subcontractor available in other Sage Timberline Office
applications.

To Set Up a Subcontractor in Address Book:
1 In the estimate, right-click in an empty cell in theSub Name column and select Create
Subcontractor > Create Subcontractor in Address Book from the shortcut menu.

2 Complete the information for the subcontractor in theCompany Setupwindow.

3 Click [Save & Close].
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NOTE: You can useEdit Subcontractor in Estimate from the shortcut menu to add an
existing estimate subcontractor to Address Book.

Refresh Estimate Subcontract Information in Address
Book
When you refresh the subcontractors in an estimate, Estimating copies the appropriate
information from the specified company data folder (Database Settingswindow) to the
estimate and identifies any new contacts in your estimate that are not in Address Book. You
should refresh your estimate subcontractor information if you have opened a new database to
work with the estimate or if you think the subcontractor information in the estimate is out of date.

NOTE: You cannot refresh your offline copy of Address Book if the shared network
Address Book is in use. Before you refresh your offline copy, make sure other users are
not using the shared network Address Book.

To Refresh Estimate Subcontract Information:
1 If your database is not connected to a company folder that contains Address Book or Job
Cost data, connect it now.

2 From the Takeoffmenu, select Refresh Estimate Subs from Address Book. Estimating
opens theRefresh Vendors and Subs from Address Bookwindow and begins refreshing
the subcontractor or vendor information in your estimate.
During the process, a progress bar appears at the bottom of the window. If Estimating
encounters any conflicts between your estimate and Address Book, it creates a report that
you can print when the update is complete. This report identifies any new contacts in the
estimate that are not in Address Book. You can use this list to quickly identify the new
subcontractors in the estimate and add them to Address Book.

3 When the process is complete, click [Close].
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Database Editor is aMicrosoft Windows-based editor for Estimating databases. You can use a
familiar spreadsheet interface to:

n View, create, edit, and delete group phases, phases, and items.

n Filter and find data elements.

n Replace text within all data elements or a range of data elements.

n Undo edits.

n Renumber phases or items tomove them in the database.

n Save and select layouts for phases and items.

Start Database Editor
From theWindows Start menu, select Program Files > Sage Timberline Office >
Estimating > Database Editor.

Open a Database
You can open only Estimating files. Use the steps that follow to open a database:

1 From the Filemenu, select Open.

2 Navigate to a folder that contains an Estimating database.

3 Select pei.dat.

4 Click [Open].
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Figure 15: The Database Editor

Create and Edit Database Elements
Database Editor validates the formatting of data when you create and edit records.

To Create Data:
1 Open thePhases or Items table.

2 Select a row or cell.

3 From theEditmenu, select Insert row or right-click and select it from themenu. Database
Editor inserts a row above the one you selected.

4 Type data in each required cell.

5 When you finish typing data in the row, press ENTER. Database Editor validates the data,
writes it to the database, and inserts a new blank row.

6 When you finish creating data, press ESC in a blank new row (you can also select a cell in
another row). Database Editor exits insert mode.
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NOTE: When you finish entering data in a new row, Database Editor re-sorts the table
and inserts a second row at the place you started. For example, you finish inserting phase
100.000 above phase 500.000; the new row remains above phase 500.000 and phase
100.000moves to its place in the sort order.

To Edit Existing Data:
1 Select a cell.

2 Type data in the cell.

3 Select a new cell. Database Editor validates the data and writes it to the database when you
leave the row.

Save and Select Column Layouts
You can save column layouts under different names and apply them at will. When you save a
column layout, Database Editor remembers:

n The columnwidths and locations.

n The column names.

n Whether or not columns are visible or locked.

To Save a New Column Layout:
1 Right-click a column header and select Save Layout As.

2 In theSave Layout Aswindow, type a name for the layout. You can type up to 30 characters.

Figure 16: Saving a New Column Layout

3 Click [OK].
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About Filters
Filters let you display only the data that you want to view. For example, you can create a filter to
display phases within a certain range or items with the word concrete in the description. You can
also use a filter to easily locate empty fields. This allows you to quickly focus in on only the
items you need tomodify.

To Modify Filters:

Use the Modify Filterwindow to create new or edit existing filters.

1 Open theManage Filterswindow. From the Toolsmenu, selectManage Filters.

Figure 17: TheManage Filters Window

2 Click [New] to create a new filter or select a filter and click [Edit] to modify an existing filter. If
you create a new filter, type a name for the filter in the Filter box. The first character must be
a letter or a number. You can type up to 30 characters.

3 Select a field from the Field Name list.

4 Select an operator from the Test list.

5 Type a filter value in the Value column. You can type as many characters as you want.

6 Continue setting up rules in the filter using either And orOr to separate them. You can set up
to ten rules for one filter.

7 Click [OK].
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Appendix: Keyboard Shortcuts
Estimating offers many keyboard shortcuts that you can use to access commands. The
shortcuts available depend on your cursor placement; some shortcuts are specific to certain
windows or spreadsheet columns.
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Table 3: General Shortcuts and Hotkeys

Shortcut Result

F1 Displays Help for a field or button.

SHIFT+F1 Displays help for toolbars and screen areas.

F2 Lets you edit the contents of a cell or field.

CTRL + F4 Closes the active window.

ALT + F4 Closes all Estimating windows.

F7 Scans for the next incomplete cell.

F8 Lets you edit database records.

F9 Starts Digitizer (if you ownDigitizer).

F10 Opens a list.

F12 Starts ePlan Takeoff (if you own ePlan Takeoff).

SHIFT +
F10

Opens the shortcut menu.

CTRL +
F12

Shows information about the database and the locale.

ALT + F Displays a drop-down list.

ESC Ends the field edit without saving your entry.

Expands an entry in a list.

Collapses an entry in a list.

Underlined
letter

Executes amenu command or button when you type ALT and
then the letter.

ALT+[S] Opens the Search area for a list.

ALT+R Moves your cursor to the Search field.
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Table 4: Spreadsheet Shortcuts and Hotkeys

Shortcut Result

CTRL+[1] Opens the One-time Item window.

CTRL + D Opens the Detail window.

CTRL + E Goes to the first visible equipment column.

CTRL + F Opens the Find/Goto window.

CTRL + I Lets you edit the selected item in the database.

CTRL + L Goes to the first visible labor column.

CTRL + M Goes to the first visible material column.

CTRL + N Opens the Notes window.

CTRL + O Goes to the first visible other column.

CTRL + P Lets you edit the selected phase in the database.

CTRL + Q Goes to the Takeoff Quantity column.

CTRL + S Goes to the first visible subcontractor column.

CTRL + T Goes to the first visible total column.

F2 Lets you edit a cell.

F3 Finds the next item that matches the current search
criteria.

F4 Opens the Totals window.

F11 Opens the Calculator window.

ESC Cancels your changes to a cell.
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Shortcut Result

CTRL + PAGE
DOWN

Goes to the next spreadsheet sequence tab.

CTRL + PAGE
UP

Goes to the previous spreadsheet sequence tab.

CTRL+[=] Expands the entire spreadsheet one level.

CTRL+[+] Also expands the entire spreadsheet one level.

CTRL+[-] Collapses the entire spreadsheet one level.
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